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Why Java?

= Application programming trend
» Widespread availability of education - colleges, industry, books,...
» Relatively new and appeals to new programmers

» Widely recognized and discussed in the industry
= Evolving as an industry standard
» Implemented in customer environments around the world
» Availability of many off-the-shelf applications, development toolkits, ...
» Used widely in the web-based arena
= Program characteristics
» Object-oriented

» Portable and platform-neutral
* Portable - compile once and run everywhere
» Standard interfaces

- Packaged classes
- JDBC access to data
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J2EE Architecture

= Java 2 Platform, Enterprise Edition

» A standards-based architecture to enable development of multi-tier distributed

applications

» Recognizes long term dependency on existing legacy systems
« “Enterprise Information Systems (EIS)”

» The business logic in the middle tier runs as Enterprise Java Beans (EJB)
+ can call other EJBs (anywhere) or EIS systems

= J2EE Connector Architecture (JCA)
» An extension of J2EE architecture

» Enables a standard API to be used for al

access to any EIS

* eg. EJB access to an IMS Transact

= JDBC

» Java classes for accessing databases
using SQL

» Can be used as a "data connector"
» Provides access to IMS DBs

Puee

ﬂg?
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Webserver
business logic in
Java, EJBs,
components,
distributed objects,
etc.

Browsers, PC's,
network
computers, PDAs,
kiosks, ...

Back-end
business logic
and data access|
-- IMS, DB2, ...

servers,
servlets,

Java Server
Pages
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IMS e-business Java Strategy

IMS & | ms
JavaJ~~ [iConnect

e-business
evolution

Access Enterprise Integration On Demand

e : . Optimize operations
Buying, not browsing namically respond to

; . » d 7
Working, not surfing t¥1e needs of customers,
employees, partners.

“Getonthe Net 7 |

Transact Integrate
Internally

A ccess Integrate

e ma= I
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Java and IMS

Web access to IMS transactions from remote environments
» IMS Connect
» IMS Connector for Java

IMS Java application support within IMS
» Development and runtime support

» Access to IMS resources
Web access to IMS DB
» From IMS and z/OS environments
« CICS, DB2 Stored Procedures, WebSphere z/OS

» From Remote environments
XML, SOAP and Futures
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Web Access to IMS Transactions From Remote
Environments

» IMS Connect
» IMS Connector for Java

(@ buginess on demand software
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IMS Connect - the Glue that Binds

= Provides TCP/IP socket access to IMS from Remote programs
» Direct connection

» Published interface that can be used by any sockets program

« Supports a variety of connectors (sample programs and tools)
= Provides access to any IMS in a sysplex

IMSB
COMTI
Visual Basic
PowerBuilder ,’
Cobol
Assembler
C/C++ TCP/IP
— IMS Connect IMSA
Java

Java Applet
BROWSER

Web VTAM
Server Web Server Websphere IMS Connector
rogram for Java

WebSphere 'f'\gf ‘gl‘)’gnector
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IMS Connect ...

= A product (5655-K52) that provides connectivity support between
TCP/IP applications and IMS/TM

» Component ID 5655E51 (service), FMID HIC2210
» Configured on an OS/390 or z/OS server

« SMP installed and maintained
= Benefits and Value

» Supports TCP/IP sockets access to IMS transactions and commands

* No requirement to modify existing IMS transactions
» Provides a general purpose and structured interface

* For the IMS Connectors
* For user-written clients
» Provides a strategic base for new connection technologies

* IMSPLEX
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IMS Connect ...

= Functions

4
4
4

Persistent Sockets

Enhanced Dump formatting capability

Enhanced manageability with SMP/E Install/Maintenance
Asynch output capability with IMS V7

Send only capability: Connect, Send (sendonly) , Disconnect
Local/390 support

Unicode

ACK/NAK required notification support
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IMS Connect ...

= Functions ...
» IMS Connector for Java J2EE Runtime support for WebSphere access
« Used with VAJava/WASADIE's IMS Connector for Java
» Two-phase Commit Support in Local 390 environments
» Security enhancements

» Passticket support
* Trusted User support
» More Granular timeout (eg. by transaction)

» User message exit limitation relief

» Auto reconnect to a recycled IMS system
» IPV6 support
» IMS V8 support - Operations Manager distributed interface
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IMS Connect ...

= IMS Connect V2.1
» PING support
« Determines IMS Connect availability
J2EE XA Two-phase Commit Support

* Distributed environments

« z/OS environments across TCP/IP
SSL support

* Enhanced security control
» Commit mode 0 — persistent socket support

- PQ80468

v

v




| IBM Software Group | DB Information Management Software

IMS Connect ...

* = IMS Connect V2.2 — just announced...

» Commit Mode 0

« Persistent socket support (delivered in V2.1 with PQ80468)
- Extends CMO, Synclevel=confirm to persistent connections
* Purge not deliverable support

- New IRM_F3_PURGE flag to request that an undeliverable message
be purged from the IMS message queue

» New IMS Connect z/OS (MVS) commands

*  Modify command support - “F jobname,command”
* Where command is in the format verb resourcetype keyword(value)
- Verbs are: QUERY, UPDATE, SHUTDOWN, DELETE
- Resourcetypes are: DATASTORE, PORT, MEMBER and UOR

- Keyword and values: represent atributes, filters, etc. that apply to the
command

-~ e.g., F IMSCONN, QRY DATASTORE(IMSP) SHOW (ALL)
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IMS Connect ...

= IMS Connect V2.2 — just announced ...

» Cancel Timer support
* New “C” flag in IRM-F4 which requests the cancel of a timer
associated with a wait for data from IMS
» New RESUME_TPIPE single with wait option
* New flag IRM_F5 SWAIT to allow a wait for a single message if
none are currently queued in IMS

« Existing flag IRM_F5 ONE requests a single message, if none are
available then a timeout occurs

» Support for a new product IMS Connect Extensions (5655-K48)
» Event recording for performance and data analysis
« User Exit HWSTECLO

- Provided by IMS Connect
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IMS Connect ...Reminder

IMS Connect V1.1
» End of Service — 11/30/2003
IMS Connect V1.2
» Marketing Withdrawal — 09/03/2003
» End of Service — 04/30/2005
IMS Connect V2.1
» Current
IMS Connect V2.2
» Just announced
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IMS Connect Extensions

= New product 5655-K48
» Enhances and augments the services of IBM IMS Connect:

°

Event Recording

- Receives notification of significant events, as transactions are being
processed by IMS Connect

Collects and reports on performance-monitoring and system availability data

» Additional features:

Allows for dynamic transaction routing to alternative datastores and
workload balancing

Supports pacing of incoming messages to datastores to prevent overloading
Improves security
- Optional verification of user access to IMS Connect

- Enhanced performance of userid/password validation by keeping
ACEEs in memory

Supports dynamic addition, reload, deletion, disabling or enabling of user
exits
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Access to IMS Connect

= IMS Connect-based Solutions
» Customer-written RYO

v

Provided by multiple vendors
IBM WebSphere — IMS Connector for Java *

v
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phe

IMS Connector for Java

= Development code provided with WebSphere Studio Application Developer

Integration Edition — WSADIE

» Assists in the development of Java programs that access IMS

+ Hides the complexity of socket programming and interaction with the IMS
environment from the application developer

= Runtime code (IMS JCA Resource Adapter)
» Runs in an application server and communicates with IMS Connect

WSADIE

IMS Connector for
Java
(development)

-
f===-\

LOCAL

(390 or z/0OS only)

IMS Connector

IMS
Connect

for Java
(runtime)

TCP/IP

Development | Deploy > Runtime
Environment

Environment

XCF

IMS

> 40
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WSADIE Development

WebSphere Studio Application Developer Integration Edition

WSADIE

MES

COBOL

Resource
Adapter

U WebSphere
Unit Test Environment

EAR
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Application Deployment

=

Application \
Installed
EAR Applications —
T IMS ||
IMS Connect
ﬁ Resource
Adapter
imsico.RAR U

la. 99
QIJO 0" =i
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IMS Connector for Java ...

= The use of IMS Connector for Java with WebSphere can
» Facilitate accessing IMS from a Web Server
» Integrate IMS into an e-business Application
« J2EE Architecture
* Enterprise Java Beans

» Support publishing an IMS transaction as a Web
Service for others to find and access
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Websphere Studio

WebSphere Studio Enterprise Developer (WSED)

*Advanced J2EE
Developer
°Integrate existing

*Basic J2EE
Developer

*HTML/JSP/Graphics
*CICS, IMS, HOD,

J2C, etc.

~

*Enterprise Developer
*IDE for z/OS appl

*Create new EIS
applications

o *Create Wi EIS applications XML Converter
*Create Web Content Content into J2EE -etc..
*EJBs Applications
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WSADIE and Enterprise Services

= WSADIE is based on the concept of oo
an “Enterprise Service” EEE
» also referred to S|mp|y as a “Service” ?:;til;?:gplicatiun Developer Integration Edition
» For example, you use WSADIE to S

set up an IMS transaction as an
Enterprise Service

= An Enterprise Service is not directly
usable in production environments

» It needs to be “deployed” in a way that makes it usable
= There are two key ways of deploying an IMS Enterprise Service
» As an EJB within a J2EE application

» As a Web Service (or SOAP Service)

» (It could be deployed as a Servlet. But it is no longer recommended to
access IMS directly from a Servlet, since there is a lack of “quality of
service”)

= A Web Service is a specific implementation of an enterprise service

Puee
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Enterprise Java Beans (EJB)

Reusable components E VABEANS
Focus on business logic

Easy to develop and deploy
Run in the EJB Container

» Provides services such as:

- Life cycle management @ -m_.

+  Security

+ Transactional support -$
in
Corr

Web Server| EJB Container

+ Connection pooling

» Similar in nature to how an
IMS system provides

services to transactions Transaction
Server

Application Server
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Web Services

= Network programs that are accessed by sending and receiving SOAP
messages over HTTP/HTTPS, with an interface defined by WSDL
descriptions

» SOAP - Simple Object Access Protocol
* An XML protocol that defines both a message and a target application

» UDDI - Universal Description, Discovery, Integration
- UDDI servers act as a directory of available services and service providers
« SOAP can be used to query UDDI for services

» WSDL - Web Services Description Language

+  An XML format to describe the web service interface
- Operational information about the service:
— Service interface
— Implementation details
- Access protocol
— Contact endpoints
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Services Fundamentals

WSIF Java API for invoking services
Web Service Invocation Framework
WSDL @ Formal service descriptions I
Web services description language
SOAP @ Service interactions I
Simple Object Access Protocol
XML @ Universal data format I
Extensible Markup Language
Program that represents the
Proxy grar P
service at the server

Simple, Open, Broad Internet Support

11 'Y B = S
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The Service Provider Builds the Service

= A service consists of:
» An implementation artifact (e.g., a Java
class, EJB, IMS transaction, etc.)
» 3 WSDL files that describe the service:

« Abstract Service Interface

— Description of the operations and
the messages they exchange

- WSDL “portType”
* Implementation binding

— Description of how service
interface is implemented

* Implementation service
- Location of the service
= To Generate the service (WSDL)
» Import C, COBOL, MFS description of
transaction input and output messages

» Provide connection, interaction properties

Service

Interface
Binding

Location

Implementation
Artifact
(IMS transaction)
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WSDL

= Servicelnterface WSDL file(interfacefilename.wsdl)
» contains data type information
* Input Message
*  Output Message
» port type
* operation
= Binding WSDL file(interfacefilenameBinding.wsdl)
» contains transaction-specific information
* Input/Output Message Codepage
« operation binding properties
* IMS Tran or IMS Command

* Lterm name
= Service WSDL file(interfacefilenameService.wsdl)

» contains host-specific information

* Hostname
*  PortNumber
« DatastorelD
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The Service Consumer uses the Service

= Generate a proxy for the
consuming application to use Consumer

» Represent the service that is
deployed to the server

Application

» Handle the sending and receiving l
of data to the service '
» Expose only the methods of the <Proxy>
service the application needs

= The proxy uses Web Services | T
Invocation Framework (WSIF) Provider

» WSIF parses WSDL and )
dynamically calls the service Service

o

IMS transaction

IMS Resource Adapter
and IMS Connect
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Types of Service Proxies

= Java proxy

» Use tooling to generate a Java
proxy for the enterprise service

» Test enterprise service in “two-tier”
environment

* Invoke Java proxy from a
simple Java class

* No application server (non-
managed)

* No J2EE Quality of Service
(QoS)

—For example, no
connection pooling

| Java Proxy

Service

Interface
Binding

Location

Implementation
Artifact

(IMS transaction
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Types of Service Proxies

= EJB or SOAP proxy

>

Use to access a deployed service
running in WebSphere Application Server
(WAS)

Implemented by a stateless session bean
(EJB)

EJB synchronously handles the client
requests to and responses from the local
service

J2EE component (EJB) means managed
environment (e.g., connection pooling)

Described by inbound binding WSDL files

* How the service is provided to
consumers (clients) — SOAP or EJB

Wizards generate proxy and deployment
descriptor for EJB

Session EJB Service

Service

Implementation
Artifact
(IMS transaction)
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Deploying to WebSphere Application Server
(WAS)

= Install the IMS Resource Adapter

» Resource Archive (RAR) file is included in the files provided with the
IMS Connector for Java runtime

= Configure a J2C IMS Connection Factory
» Specify a JNDI name

» Specify custom properties (host name, port, datastore, max
connections, etc.)
= Install the enterprise application (EAR)

» The Enterprise Archive (EAR) file can be created by exporting the
application from WSADIE

» Map the resource reference of the application to the configured
connection factory
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WAS Environment

= WAS Tooling is used to
» Deploy IMS Connector for Java
» Set up Connection Factories
» Deploy J2EE applications

+ Deployment descriptor specifies sign-on and transactional
requirements, together with connection factory reference
information

= WAS runtime provides Qualities of Service to EJBs and IMS TM
access

» Connection pooling, signon support, distributed 2PC, etc

= Other features provided in this J2EE environment include:

» SSL, support for Commit Modes 0 and 1, retrieval of asynchronous
output (with Commit Mode 0), and timeout specification on a message
by message basis
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IMS Web Services & WAS

WebSphere Application Server Production Environment

Web Service Invocation Framework (WSIF)

IMS
WSIFDynamic Provider_IMS

Resource

JCAOperation

IMS
Service

Format Handler

Byte Stream

SOAP Proxy

MPP/IFP/BMP

IMS
Application
Program
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IMS Java Application Support Within IMS

» Development and runtime support
» Access to IMS

(@ buginess on demand software



| IBM Software Group | DB Information Management Software

IMS Java

= Capability to write, compile and run IMS Java programs

» Development environment

* Provides a set of packages (groups of classes)
— Allow access to IMS services
— Support APIs familiar to Java programmers

» Runtime environment supports dependent regions
+ JMP and JBP for JVM

= Benefit

» Incorporation of the Java programming model into the IMS
environment
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Development Support

= IMS Java class library

» A Java class is pre-written reusable code that can be invoked from a
program

» IMS Java Class Library

« Set of packages that contain groups of classes

— Code to access IMS message queues and databases
= Value

» Allows Java programmers to code IMS applications

« Requires only basic IMS knowledge
» Supports all major IMS capabilities
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Runtime Support

= Persistent Reusable Java Virtual Machine (JVM)
» Supports a JVM in an IMS environment

« Two types of dependent regions in IMS - JMP and JBP
= Value

» Supports the traditional Java execution model

‘ Java S/390 or z/OS directory IMS JMP or JBP region
Compiler
Java (javac) - specifies directory
Source ‘ @ pathname to retrieve

Java Java program

Bytecodes

(JVM)
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Runtime Support ...

= Persistent Reusable JVM

» Dependent on a minimum of JDK 1.3.1S

« Packaged in "IBM Developer Kit for OS/390, Java 2 Technology
Edition" plus APAR PQ55333

» Provides:

+ Master JVM
— establishes the JVM runtime environment
- remains until IMS Dependent Region Termination
* Worker JVM
— Transaction processing JVM runtime environment
- "reset" after transaction commit
» For IMS, the JVM can only run in JMP for message driven programs

+ JBP for non-message driven programs (also supported in DBCTL)
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IMS Java Class Library

IMS DB Metadata
Business Logic

IMS Dep. Region
Transaction and

Message
Processing

Customer Code |

IMS Java Class Library

Mapping to
EoPag e _—

JDBC, JCA
interface

Javato C
interface
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IMS Java APls

= High-level standard database access methods
- JDBC to access IMS data
- The interface maps segments to tables and fields to columns
- Ex. "SELECT _ FROM __ WHERE "

« The IMS Java hierarchic database interface can be used to access
IMS DBs in a more familiar IMS programming style

- Ex. "connection.getUniqueSegment (mySegment ,
ssalist)"
= The use of the IMS Application Package classes to establish the
application environment and request IMS services

 Interface with the IMS message queues and request commit
services

- EX. "messageQueue.getUniqueMessage
(inputMessage)"
- Ex. "trans.commit()"
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IMS TM Java Access to IMS Data

Client

[

— N
IMS Java application
™
[[****receive an input message
InputMessage inputMessage = newlnputMessage();
MessageQueue.getUniqueMessage(inputMessage);
MSG Q //**** I MS
/[****access databases DB
: / kkkk
/[****load the JDBC driver
ClassforName(DLIDriver)
/[****establish connection to DB
get.connection(IMS psb)
[[****execute query
Select ...From .... Where
N—

/

0 0.0

IMS Databases
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DI/l Model Utility

Control statements: COBOL -
1) Choose PSBS/DBDs | sz obors
the utility. mem ers
2) Choose copybook -
members |
. DBD
3) Aliases, data types,
new fields.
L '
IMS Java
classes IMS Java

report
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IMS Metadata

DBDLIB, PSBLIB, COPYLIB

DEALER
DealerlD
DealerName
[ DeaerAgares |
MODEL SALES
PERSON
STOCK

Segmentinfo[]
)

DEALER

—_—

MODEL

—

STOCK

—_—

SALES
PERSON

DLITypelnfo[]
DealerlD
DealerName
DealerAddres

DLITypelnfo[]

_—

DLITypelnfo[]

\DLITypeInfo[]

———

DLIDatabaseView
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Hierarchical to Relational Terminology Mapping

Equivalent
Relational Design

Dealer Table

DealerID DealerName DealerAddress

0 53SJ7 | George 555 Bailey Ave.

Hierarchical Design

53SJ9 | Mary | 111 Penny Lane
Dealer |_|_ __|J 1_| 53sJ8 |Bob 240 Elm St.

53S.8 1 Bob 1240 Elm St

Seg ment 53SJ7 | George | 555 Bailey Ave. 2 53SJ9 | Mary 111 Penny Ln.

R,
%%’76/
JO ,
N

Model LU — Model Table
PR27 | Dodge | Durango
Segment [ Fr13 | Toyota | Camry D Make Model Dealer
Uu45 | Dodge Viper 53SJ7 0
PR27 | Dodge Durango 53SJ7 0
FF13 | Toyota Camry 53SJ7 0
JR27 | Dodge Durango 53SJ8 1
Note: Segment Names ~ Table Names WJ45 | Mercury | Cougar 53S8J8 1

Segment Instances ~ Table Rows

Field Names ~ Column Names
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SQL Parsing
SOL

SELECT Dealer.Name, Dealer.Phone, Order.LastName
FROM SomePCB.Order
WHERE Model. MSRP > 50000’

AND Order.Date >= 5/1/2003’

AND Order.Date <=5/31/2003’

SSA List

DEALER *ID

MODEL (MSRP  GT50000)

ORDER (DATE  GE20030501&
DATE  LE20030531)
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Web Access to IMS DB

»From IMS and z/OS environments
»CICS, DB2 Stored Procedures,

»WebSphere z/OS
»From Remote environments
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IMS TM JDBC Access to Data

= Commit/rollback of resources

» Must be activated in the Java application by using IMSTransaction
methods Managed by IMS syncpoint processing Note. When DB2
JDBC is used RRS Manages syncpoint processing

Server-Side Server-Side
Presentation Business Logic
Management

Applicat ion

Control
Region

ClassforName(DLIDriver)
get.connection(IMS psb)
Select
From
Where
Close

Client side
Connectors

IMS
Connect

IMS z/OS Platform

IMS Application Server
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CICS and IMS JDBC Access

= Commit/rollback of resources

» Can be activated in the Java application by closing the connection
Managed by CICS syncpoint processing

Server-Side
Presentation
Management

Server-Side
Business Logic

CICS
JCICS/EJB
Region

Client-Side
Connector i‘

CICS z/OS Platform

CICS Application Server




A callable interface to access IMS data directly

Provides another means for IMS users to access the valuable
information stored in their IMS Databases.

Provides for failure isolation and independent resource recoverability
Syncpoint processing is coordinated through the use of z/OS
Resource Recovery Services (RRS)

0S/390 PGM

DL/1 call

> wlo o

RRS Commi

IMS
DB
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IMS Open Database Access - Background

IMS Databases

-@@
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DB2 and IMS JDBC Access

= Commit/rollback of resources
» Activated by DB2 Managed by RRS syncpoint process

Server-Side Server-Side
Presentation Business Logic
Management

WLM
Runtime

DRDA Client

EXEC SQL CALL PGMA ‘

*

Commit

SRRCMIT

DB2 z/OS Platform

DB2 Application Server
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The WebSphere Software Platform

= Web infrastructure software that helps
companies at each stage of e-business
development

» from startup,

» to integrating and exploiting business
processes,

» to handling high volume Web transactions.

Server-Side Server-Side /

Presentation Business Logic

Application developers focus on

Web EJB | - ,
S i - Enterpise business logic (components)

Systems

Containers and connectors
conceal complexity and
promote portability

Servlets

Client-Side =
Presentation

iy y y |

Components inherit qualities of
service of the underlying

Java 2 EE Platform
platform

Web Application Server
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WebSphere z/OS and IMS JDBC Access

= Commit/rollback of resources
» Activated by WebSphere Managed by RRS syncpoint process

WAS 5.0
Server-Side Server-Side
Presentation Business Logic
Client
Web EJB
Container Container
Client-Side o

Presentation

Java 2 EE Platform

Web Application Server
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The Big Picture — IMS TM/DB

Applications & | '
and Data

Pervasive

Devices Web Server

' Ao 4 Storage Area
Slgrvser \ Network
/ Application

y. -3
Server ~ =

N

& k% J Business Partners
Wi and External
\i_#;_ll/ Services

Internet Firewall
Load Balancer
Internet Firewall

Combining the strengths of IMS Transaction and Database Managers
with the flexibility of e-business technology

Puiee
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= EJBs can access an IMS
Transaction

» using IMS Connector for Java
» and IMS Connect
»  from any WebSphere platform

= EJBs can access an IMS Data Base
» using JDBC (or DL/1)

»  from WAS for z/OS with IMS
V7/\V8

» from Distributed WAS with IMS V9




| IBM Software Group | DB Information Management Software

IMS Solutions

= JDBC access to IMS DB (delivered by IMS)
» Currently supported on WebSphere z/OS and IMS Java support

z/0S

» Future support with IMS V9 — IMS Java Remote Data Services

Distributed
IMS JDBC
adapter

IMS JDBC
adapter

CM: container managed (supports global transaction semantics)
BM: bean managed (supports local transaction semantics)
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IMS V9 Java Remote Database Services

IIOP over SSL

CM - Container Managed
BM - Bean Managed
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WebSphere Runtime for RDS
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IMS JDBC — The Big Picture
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XML, SOAP and Futures

(@ buginess on demand software
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= Processing XML Documents in New IMS
Applications Today

» Customers can write IMS C++ or IMS
Java applications using the XML Toolkit for
0S/390

» Customers can write IMS Cobol or PL/I
application using XML support for COBOL
and PL/I

= Bridging XML and Existing IMS
Applications Today
» Using WebSphere MQ Integrator Pub/Sub

» Using IMS Connector for Java
= XML and IMS V9

» Storing/Extracting XML documents
into/from IMS Databases

P ...
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IMS XML Enablement using WSAD-IE

UDDI may be consulted to
dsicover the service at application
build or runtime.

Schema

WSDL file describing this service .
conforming XML

is registered in UDDI prior to discovering ﬁ

and invoking the Service.
---------------------------------

Schema
conforming XML

XML Inbound "XML/SOAP"
pass-thru

Servlet

N

Web Service

E.g. SOAP via HTTP
Request =

XML Outbound

Artifacts generated/provided by
WSAD-IE

';h H ” IMS
; : »° Connect

TCPIIPE

s sasEEEEEE R Enn

( IMS \

IMS Trans.
Applicatio
n
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IMS V9 XML-DB - What is XML-DB?

= A methodology for storing and retrieving XML documents into and
out of standard IMS databases

» Language Independent Design
» XML Schema Metadata (Structural Metadata)
» DL/I Metadata (Physical Metadata)

» Two storage types

= XMS Java is the Java enablement of XML-DB using an extended
IMS Java JDBC interface
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XML-DB Highlights Overview
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Decomposed vs. Intact Storage

= Decomposed (data-centric storage)
» XML tags are stripped from XML data

v

|dentical as current IMS storage

» Strict data-centric XML Schema validated data
EBCDIC encoding

» Searching on IMS Search Fields

v

= Intact (document-centric storage)
» Entire XML document is stored (including tags)

» Relaxed un-validated data

» Any desired encoding is possible

» Searching is through XPath specified and generated Secondary
Indexed Side Segments
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XML-DB Highlights - Decomposed Data

= Retrieve - Compose XML document from any existing traditional

database.
= Insert - Decompose XML documents back into same DB.

= Same data can be read by existing IMS applications.

Control JBP or JMP Dependent Region
Region AN _—
/

IMS Java
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XML-DB Highlights - Intact Data

= |nsert/Retrieve/Delete new XML documents INTACT in new IMS
databases.

= Intact data not expected to be understood by other IMS applications.

XML document

JBP or JMP Dependent Regi
Control

Region

:

IMS Java

I

Intact XML docs
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= An XML lightweight messaging
protocol

* Request and Response
messages

» Request invokes a method on
a remote object

» Response returns result of
running the method

= SOAP defines an "envelope"

» "envelope" wraps the message
itself

» message is a different
vocabulary

» namespace prefix is used to
distinguish the two parts

SOAP (Simple Object Access Protocol)

(@ )
a standardized way of using
XML to define both a
message and the target
application

application-specific
message vocabulary
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XML or SOAP
Request

= Use WebSphere Application
Server (distributed or z/OS WAS)
with the SOAP Protocol
» IMS COBOL and C applications

+ Since WSAD-IE 4.1

+ Since WASEE 4.1 & WAS
z0S 4.04

» IMS MFS-based applications

+ Since WSAD-IE 5.0.1

+ Since WASEE 5.0 & WAS
z0S 5.0

» IMS PL/I applications (direction)

Browser

TCP/IP

(MFS-based)
IMS Application
in COBOL, C,
Java, or PL/I, etc.

= The IMS transaction, accessed via
SOAP, can be “published” as a
“Web Service”
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IMS SOAP Gateway

= Sofar...

» ... IMS provides services for IMS applications using (a) the WebSphere
Application Server, (b) IMS Connector for Java, and (c) IMS Connect to:

+ transform existing IMS transactions into services by using e.g. WSAD-IE to
create service definitions for IMS transactions

+ deploy these service definitions to WAS to make the IMS services available

as Enterprise Java Bean (EJB) services or Simple Object Access Protocol
(SOAP) web services

= The IMS SOAP Gateway is an XML based connectivity solution

» enable existing/new IMS applications to communicate outside of the IMS
environment using SOAP

» provide the ability for non-WebSphere customers to access IMS-based business
logic

» retrieve IMS WSDL files out of the UDDI directory and fit them into a tool (such as
Microsoft .Net tools, or Apache Axis server tools) to generate SOAP messages to
be sent to the host to run IMS applications

» also use the standard APIs, such as Java API for XML-based RPC (JAX-RPC), to
create both client and server code out of the generated WSDL files (RYO)

[Puiee
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IMS SOAP Gateway

SOAP client IMS SOAP gateway IMS Connect IMS
application

e.g. Java, SOAP/ XML - atewa IRMLLZZXML Adapter
.NET, SAP OA snnecto Task
(HTTP) endpo (TCPIIP) Manager

XML COBOL
adapter

SO, P

process.r

XML COBOL
converter

any platform any platform z/0S

[Puciee-
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IMS SOAP Gateway

= Technology preview (demo) available at:

» http://www.ibm.com/ims (then look for SOAP for IMS)

= This sample demonstrates how the input SOAP message can be
sent to the IMS SOAP gateway to drive a back-end IMS transaction
and to send output SOAP messages back to the client
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Open and Integrated IMS e-business

= Application Development/ Connectivity
» Seamlessly integrate distinct enterprises
= B2B data exchange
» Modernizing IMS Transactions and data
XML, SOAP/Web Services to access IMS transactions

>
» IMS XML data storage
>

Distributed access to IMS data
XML, SOAP & Web Services = Open Integration Technologies _
JDBC, ODBC = Interoperability for Application Developers

= Integration with both IBM and non-IBM solutions
» WebSphere and J2EE compliant application server
» Designed to support open integration technologies

» Support collaboration among IMS and IBM and non-IBM
components, both within and beyond enterprise
boundaries

Web Services

» Simplify access to existing backend systems
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IMS Tools Update

IMS Tools for zZSERIES Business Overview

Autonomic Computing

IMS Tools Portfolio

IMS Problem Investigator

Summary
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IMS Tools for zZSERIES - Business Overview

The IMS Tools are a unique model in the zZSERIES tools industry
Continued commitment and investment to support future needs
Comprehensive solutions now and more coming

Independent of database server versions (release cycles)
Cross-tool integration

Products tested under same configurations and workloads as the
IMS engine

Not just a database tools vendor.
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IMS Tools Portfolio

= Utilities Management
» IMS Database Control Suite
» IMS Database Repair Facility
» IMS Fast Path Basic Tools
» IMS Fast Path Online Tools
» IMS High Performance Load
» IMS High Performance Pointer Checker
» IMS High Performance Prefix Resolution
» IMS High Performance Unload
» IMS Index Builder
» IMS Parallel Reorganization

= Application Management
» IMS Batch Backout Manager
» IMS Batch Terminal Simulator
» IMS Connect
» IMS Connect Extensions
» IMS MFS Reversal Utilities
» IMS Program Restart Facility
» Data Encryption for IMS and DB2 Databases

= Database Administration
» IMS HALDB Conversion and Maintenance Aid

» IMS Hardware Data Compression Extended
» IMS Library Integrity Ultilities
» IMS Sequential Randomizer Generator

Recovery Management
» Application Recovery Tool for IMS and DB2
» IMS DEDB Fast Recovery
» IMS Database Recovery Facility
» IMS High Performance Change Accumulation
» IMS High Performance Image Copy

TM Management
» IMS Command Control Facility

» IMS ETO Support

» IMS High Performance System Generation Tools
» IMS Multi-Dialog Manager

» IMS Queue Control Facility

Performance Management
» IMS Buffer Pool Analyzer
» IMS Performance Analyzer
» IMS Performance Monitor for z/OS
» IMS Problem Investigator
» IMS Network Compression Facility

Replication Management
» IMS DataPropagator
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IMS Connect Extensions

Enhances IMS Connect with extended features in the areas of availability,
security, and performance monitoring.
Availability:
» Provide enhanced services:
* user exits,
+ transaction pacing,
* dynamic routing,
« workload balancing and
+ extended control and
* reporting.
Security:
» Provide protection against access by unauthorized clients.
Performance Monitoring
» Comprehensive event recording for IMS Connect events

» Monitor and display IMS Connect activity and utilization in real time
» Additional reporting and analysis by IMS Performance Analyzer

Program ID 5655-K48 GA June 25
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IMS Performance Analyzer V 3.3

Improves IMS system performance by providing a wide variety of reports that
analyze performance, usage, and availability, including monitor reports, Fast
Path Log reports, New Transaction Transit reports, Transaction Statistics
Report, System Checkpoint Reports, Deadlock Reports,

Extract capability which includes CPU usage and DB update activity.

NEW reports and features that include comprehensive reporting for IMS
Connect Extensions for z/OS event collection;

NEW Dashboard report that provides a

» Quick overview of critical system performance indicators

» Springboard to other reports;

NEW BMP Checkpoint report that measures batch checkpoint frequency that
can impact online performance and system restartability;

NEW Transaction History File which allows you to collect detailed transaction
performance data and export it into DB2 for help with long-term capacity
planning and trend analysis; and an improved Report Analysis that provides
additional information to aid in the interpretation of reports.

Program ID 5655-E15 GA June 25
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IMS Problem Investigator for z/OS

= Enhances the IMS Log Formatting and Reporting capability

>

Replaces similar functionality of the IMS File Select & Formatting Print
utility (DFSERA10)

= Simplifies problem determination

4
>
4
>
4
>

ISPF dialog with powerful log viewing facility

Automated routines for input log and data selection
Multiple options for log, trace, and monitor data selection
Powerful record formatting and filtering facilities

Log record analysis that allows drill-down to the field-level

Interface to IMS Performance Analyzer

= Provides unique problem investigation capabilities

= Program ID 5655-K50
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IMS Multi-Dialog Manager for z/OS

= Enables IMS users to more quickly change between IMS sessions improving usability of
the IMS online system while improving worker productivity.

» Allows terminal users to suspend & resume a conversation

«  Simplified IMS HOLD and RELEASE commands
« Single keystroke to perform functions
»  No lost information
= Complements the existing IMS support for conversational transactions by managing the
process of holding and resuming conversations for the end user

» Separate TERM names are stored for each
» Stored IMS conversations
» One button switch between conversations

» Low overhead, instant response
= Enhanced support

»  Call Center reliable

» No application changes needed

« Uses standard IMS exits
» ETO support

* Program ID 5697-H91
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IMS Tools for zSERIES - Summary

= Focus
» New products

» Product enhancements

= Remain flexible and responsive to customers

» Adjust plans to accommodate customer requirements as business
dictates

» Deliver enhancements in expeditious manner

= Ensure satisfaction of existing customers
» Service excellence

» Responsiveness to new requests




| IBM Software Group | DB Information Management Software

Summary

= Where to find additional IBM DB2 and IMS Tools Information

» Announcements
* http://www-3.ibm.com/software/data/db2imstools/announce.html

» List of IBM DB2 and IMS Tools
* http://www-3.ibm.com/software/data/db2imstools/

» NEW News
* http://www-3.ibm.com/software/data/db2imstools/news.html
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Questions and Answers!

= We will now be conducting a Q & A session. Please press #1 so the
operator can open your line to ask a question.

= IBM would like to offer more of these training sessions. Please send
feedback to or reply to the email
questionnaire that will be sent to you in the next few days.

= If there are other members of your team that could benefit from
hearing this presentation, please have them dial in and listen to the
upcoming replay that will be available early next week.
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Thank you for your time!

= For more information about the DB2 an IMS Tools, please visit our
website at: www.ibm.com/software/data/db2imstools/




